
Accordance 10 Bible Software Workshop
I developed this resource for use with my beginning Greek class (LG1200) at Luther Seminary. It is intended to offer a 
limited introduction to Accordance for users of Greek and English. Please use or share this handout as you like. If you 
are reading it on the computer screen, you can click the topic links here and go directly to the item that interests you. 
This workshop was originally written for v9.5 of Accordance, and has been updated for v10 by Ken Simpson, 
Accordance Bible Software.

—Mary Hinkle Shore, Professor of New Testament (mshore@luthersem.edu).

—Ken Simpson, Accordance Bible Software (ksimpson@accordancebible.com)
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Help

Toolbar
When you first open Accordance, you will see a workspace. The top area of this workspace is called the 
Toolbar, and most of the functionality of Accordance is accessible from here. It can be customized by 
CTRL-clicking on the toolbar, as in many Apple applications, and it can be hidden or revealed by selecting  

the menu Window=>Hide Toolbar, or by the shortcut CMD-OPT-0 (the number zero)

1

https://myluthernet.luthersem.edu/ICS/Academics/LG/LG___1200/2011_FA-LG___1200-50/
https://myluthernet.luthersem.edu/ICS/Academics/LG/LG___1200/2011_FA-LG___1200-50/
http://www.luthersem.edu
http://www.luthersem.edu
mailto:mshore@luthersem.edu?subject=Accordance%20handout
mailto:mshore@luthersem.edu?subject=Accordance%20handout
mailto:ksimpson@accordancebible.com
mailto:ksimpson@accordancebible.com


Contextual Menus
Accordance lets you access many commands by using the right-click option of your mouse or track pad 
(control + click on the keyboard). Highlight a word, phrase, or larger block of text and right-click to check 
out what is possible from the contextual menu.

Command  + T
Command + T is not “help,” exactly, but I put it in this list because it’s a good shortcut to know. Command 
+ T will bring up the “set display” dialog no matter what window you are in. If you would like to change the 
background color, highlighting, or other things about how you see text on your screen, use this shortcut.

That Little Question Mark

Click the question mark in Accordance windows to get context-sensitive help with whatever you 
are working on. 

Error Dialog Boxes
When you ask Accordance to do something it cannot do, you will often see a dialog box. After about two 
years of using the software, I stopped closing these boxes without reading their contents. When I started 
reading the messages, I realized the error message is always helpful. Accordance tells you why a search 
or other request failed, and if the developers can guess what it is you were trying to do, they suggest 
ways to accomplish it. 

The moral of the story: there’s help in the error messages. 

Podcasts
Dr. Tim Jenny (a.k.a. Dr. J) hosts a regular video podcast, called Lighting the Lamp, in 
which he demonstrates various features of Accordance. In iTunes, you can subscribe to the 
series or watch individual episodes. You can also go to this page of the Accordance 
website for a list of the podcasts by topic. 

Look for the Lighting the Lamp logo throughout this handout for links to particular podcasts.

Video Tutorial
Accordance also offers a Training DVD, with its tracks now made available free on their website. It starts 
here, and there is navigation on the lefthand side of the page.

Elements of the Screen

Buttons
Here are descriptions of the most prominent buttons on your opening Accordance screen. You may hover 
over any of these buttons at any time to see a tool tip about what they do. 

Click the smaller “A” to make the font smaller in the window below this icon. Click 
the larger “A” to make the font bigger.
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Click on the graph icon to see a variety of details about your most recent search. 
Customizable graphs, tables, and more are available from the window that 
appears. 

Click to open a biblical text or other tool alongside those already open. 

Search Entry Box
You type search information in the long, rectangular area near the top of the search text pane. In the 
illustration below, I am searching the text GNT-T for John 1:1, so I type John 1:1 in the search entry box, 
and make sure “Verses” is highlighted above the area in which I typed. To search for words, just choose 
“Words” and type the word or phrase you are looking for in the search entry area.

Tip: the keyboard shortcut for toggling between “Words” and “Verses” is CMD + the semicolon key “;”. 

Tip: With your cursor in the Search Entry Box, right-click (or CTRL + click) for a menu of search 
commands and symbols.

Tabs
Accordance opens search results in a new tab.

Names of Tabs
By default, the tab name is the text or tool you are working in, and then a number (depending on the 
number of tabs open that contain that text or tool). In the illustration above, the tab is named GNT-T 2. To 
rename a tab, just right click or control + click on the tab. The context menu includes the item Set Tab.... 
Choose this, then Active Tab Name. A box will appear where you can type any name you choose. 
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Recycling Tab Contents

When the recycle button at the far right of the search are are blue, the tab is set to recycle 
contents. This means if you do a search, then do a second search, your first search results 
will be replaced by the results of the second search. 

Two things about recycling:

1. You can always get your last searches back in the history menu which is in the drop 
down menu under the magnifying glass at the left end of the search entry field. 

2. You can set the tab to stop recycling by clicking the recycle button. When they are 
grey (not blue) the tab will not be used for new search results. New results will open 
in a new tab.

Arrows, etc. at the Bottom of the Workspace
At the bottom of the Accordance search results window, you will find a bar like this one. Click on the blue 
up and down triangles or arrows to go through your results verse by verse, chapter by chapter, or book by 
book. You can also go to a particular place in your results by clicking on the small black arrow to the far 
right of the screen, and seeing all the books represented in your search results.

Instant Details
To show or hide instant details about whatever you are hovering over, choose the Window menu, then 
Instant Details. This window can be resized and moved around your screen. You can also make the font 
bigger or smaller, and copy the window’s contents. 

Examples of Instant Details

• If you are reading a Greek or Hebrew text and you hover over a word, that word is defined and parsed. 

• If you are reading a Bible with notes, and you hover over a footnote number, that note appears in 
Instant Details. 

• If you are in a lexicon, or another tool, and you hover over a link, the contents of that link appear in 
Instant Details. 

Copy & Paste Contents of Instant Details
Have you had this problem? You see something in the Instant Details window that you want to copy and 
paste, but every time you try to get your mouse pointer to that window, the details disappear. And when 
you figure out how to stop the details window from changing (by holding down the Shift key), still, you 
can’t copy and paste the information in Instant Details. 

In whatever text or tool is making use of Instant Details, right-click (or control + click) and choose “Copy 
As...” then Instant Details from the context menu. The details are now on your clipboard. You can also 
hold down the shift key and click the copy instant details button. When you hold the shift key, the instant 
details “freeze” until you let it go.
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Library Window

The Library window includes a list of all your texts, tools, and notes, as 
well as any workspaces you have saved. You can rearrange resources 
here, add divider lines and otherwise organize your materials for quick 
access. 

Opening the Library Window
To open the library window, choose Library Window from the Window 
menu. Shortcut is command + option + 1. 

Ordering the Library Contents
To reorder resources, click and drag them. You cannot mix texts and tools, 
but you can reorder materials within a category.

The order of resources matters for certain shortcuts. For instance, when 
you triple-click a word in a Greek text, the first Greek Tool in your Library 
list will open to the definition of that word. 

Organizing Library Contents
Click on the small gear at the bottom of the library window 
to see choices for further organizing your library.

Dr. J. has a podcast on the Library Window and how to 
organize it. Click to download podcast #4 (m4v).
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Amplify Tool

For some installations of Accordance, the Amplify Tool is not on the toolbar. As described above, 
CTRL-click on the toolbar area and select “Customize Toolbar…” and a sheet will appear that will 
allow you to rearrange the Toolbar

 Some tips:

• Notice that you can click and hold certain buttons (those with a tiny black triangle under them) for a 
list of what they will open.  

• Find out more about some of the buttons under Language below.

• Click to download Dr. J’s podcast #5 (m4v) on the Resource Palette.
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Search 

Search for a Bible Verse or Verses

Four Steps to Search for Verse(s)
1. In the workspace, choose the Bible you want to search. In the example above, I have chosen 

NET.

2. To search for a verse or verses, make sure Verses is selected (it’s a drop down menu).

3. Type your verse reference in the search entry box. You may abbreviate, but don’t use a period 
after a book abbreviation.

4. If you wish to add a Range or a scope press the “+” button at the end of the search bar next to 
the recycle button.

5. Add the appropriate amount of context you would like to view (depending on your preferences, 
this may automatically alter after you perform the search).

6. just press “enter” on your keyboard, and Accordance will find the verses you request. 

Add Context to Your Search Results
Add verses around those that Accordance returns in either of two ways:

1. Move the slider (marked “5” in the screen shot above) for a certain number of verses before and 
after your target verse.

2. Place your cursor in a verse of your results and from the Amplify menu or the context menu (right-
click) choose Context. The book including that verse will open in a separate pane.

Sample Verse Searches

Type This in Search Entry Box See This in Search Results

Rom 5:1 Just one verse, Romans 5:1.

Rom 5:1-8 Romans 5:1-8.

Rom 5:1, 3, 5 The verses Rom 5:1, Rom 5:3, and Rom 5:8, without the 
intervening verses.

Rom 5, 1, 3, 5 Whole chapters appear in the order you type: Romans 5, then 
Romans 1, and so on.

Rom 5:1; Gal 3:27-29; Gen 1 Rom 5:1, then Gal 3:27-29, then all of Genesis chapter 1.

Rom 5:1f Rom 5:1 and only the next verse

Rom 5:1ff Rom 5:1 and all the verses in the rest of the chapter

Rom 5:1-4; 6:2-8 Rom 5:1-4 and Rpm 6:2-8. The semicolon takes us back to the 
chapter level.
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Search for a Word or Phrase
English
To search for an English word or phrase, choose an English text from the drop-down menu at the left end 
of the search entry field, and then “Words” from the blue drop down menu inside the search entry area. 
When chosen, you will see that the button says “Words”. Type the word or phrase in the search entry box 
and press “Return” on your keyboard.

A new feature in Accordance 10 is “flex” searching. In prior versions of Accordance if you wanted to 
search for an inflected English word (e.g. run/runs/ran/running) you would have needed to use an 
imprecise wildcard search (r?n*) but this also would find words such as “ring” or “renown”. Version 10 
allows you to specify a “flex” or “exact” search mode by selecting it in the drop-down menu with the 
search bar magnifying glass symbol.

An “exact” search performs a search that only looks for the exact word specified, whereas 
a “flex” search will return other forms of the same word.

Greek
To search for a Greek word, choose a Greek text (such as GNT-T) from the drop-down menu at the left 
end of the search entry field. Select “Words” in the blue drop-down menu in the search entry field. If you 
have trouble typing in Greek, type the first few letters of the word and press “return.” Accordance will open 
a dialog box listing all the similarly spelled Greek words in the New Testament. Choose the word you want 
from the list. 

For more on options for typing in Greek, see type in Greek.

To search for more occurrences of a Greek word or phrase already in your workspace, place your cursor 
in the word (or highlight all the words of a phrase), right-click and choose Search For, and then one of the 
following:

Lemma — Accordance will return all occurrences of the word or phrase have highlighted, regardless of 
what inflection (endings, etc.) they have. To try this out with a phrase, highlight τῆς δόξης τοῦ θεοῦ in 
John 11:4, right-click, and search on Lemma. Your results will occurrences of the phrase when all its 
words are in genitive case, as well as when the first two words are in accusative case. 
Inflected — Accordance will return only occurrences of the exact spelling of the word or phrase you are   
choosing/highlighting. If you try this with τῆς δόξης τοῦ θεοῦ, your results will include only the places 
where all words of the phrase are in the genitive. 

Root — Accordance will return occurrences of all the words that share the root of the word you are 
searching. (In my view, this works better with word searches than phrase searches.) Test it out with any 
form of a word related to ἀγάπη. After you run the search, click on the details graph and choose 
“Analysis” to see the three different words whose occurrences Accordance found. This has far more 
significance when performing Hebrew searches.

Tag — Accordance will find all occurrences of the tag your word has. For instance, imagine you are 
reading Romans 1:13, and you find the word, άδελφοί, “brothers [and sisters],” in the vocative. You can 
place your cursor in the word, right-click and search for tag, and Accordance will return all words that 
appear in the nominative, masculine, plural, vocative. I tried this search, limiting the search to the eight 
undisputed letters of Paul and I got these results (copied here from Details, then Analysis pane):

8



Number of different forms = 4:

! ! ἀδελφός! brother; (adj) brotherly, twin = 62

! ! Γαλάτης! Galatian = 1

! ! Κορίνθιος! Corinthian = 1

! ! Φιλιππήσιος! Philippian = 1

You can see that when Paul uses the vocative plural, it is overwhelmingly to address people as “brothers 
[and sisters]” (ἀδελφοί).

Use a Tagged English Text to Search for Occurrences of a Greek or Hebrew Word
Accordance has a few different tagged English texts available. You can recognize them because they 
have “S” at the end of the translation code, like ESVS, NRSVS, or KJVS (rather than just ESV, NRSV, or 
KJV). The NIV uses a different keying system called Goodrick/Kohlenberger numbers, and so are NIV11-
G/K. 

“Tagged” means that each word has a tag, or key number assigned to it. The key numbers relate to the 
Greek or Hebrew word that stands behind the English translation. 

In a tagged English text, place your cursor in a word, right-click, choose Search For, then Key Number. 
The search results will include all the verses that include the Greek or Hebrew word that was translated 
into whatever English word you searched, even when that Greek or Hebrew word is translated by different 
English words. In other words, you are doing a search on a Greek or Hebrew word, but you are doing it 
from an English text and seeing your results in English. 

To try this out, set your search text to KJVS, and search for the verse, Matthew 1:19. In that verse, place 
your cursor in the word “just” (which describes Joseph), right-click and Search for Key Number. Notice 
that your search results include both the English words, “just” and “righteous.” To see all five English 
words that translate G1342 (a.k.a. δίκαιος), click on the Details graph, and choose Analysis from the 
drop-down menu at the right of the Detail pane. (For fun, you might want to compare these 
results with those you get when you just search for the English word “just.”)

Find out more on working with Key Number texts from Dr. J. Click to begin download of 
podcast #25 Key Number Texts (m4v).

Limit a Search to a Particular Book or Verses
There are at least two ways to limit your search to a particular part of Scripture. 

Define Range
Click the drop-down menu shown above that says [All text] by default. You’ll see a few preset ranges to 
choose from. At the bottom of the list is “Define range...” Click that option to define your own ranges. After 
you define them, they will show up in the drop down list. Click the little question mark in the Define Range 
dialog for more on how to set ranges and organize them in the list as you like.
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Use Range Command
If you are typing your search in the search entry 
box, type what you want to find, then insert 
<AND> (keyboard shortcut CMD-shift -A), then 
use the keyboard shortcut CMD-shift-R. You’ll 
see a box that looks like the one at the left, with 

a question mark highlighted. 

In this example, I typed righteous, then the keyboard shortcuts for AND and the RANGE commands. 
Accordance filled in the commands and left me with a ? to ask, “What range do you want?” I can type any 
range of verses, books, etc. there. 

Try the search, and fill in Matthew-John (or Mt-Jn, or some other abbreviation Accordance can identify) 
where the question mark is. Press “Return.” Then, click the details graph icon and choose Table, or Table 
Bar Chart to see how the use of the word breaks out across all four gospels. 

Search All
You can search for a word or phrase in all texts and tools in your Accordance library, or just all texts, or all 
tools, or all graphics, etc. Highlight the word or phrase, then either choose “Search All” and something 
from its submenu in the right-click (context) menu, or from the Amplify menu, choose “Search All.” 

You can also use the “Search all” entry box in the Toolbar, and there is a drop down in this to select the 
sort of “Search all you wish to perform (Search all texts, Search all tools, Search all graphics)

You may also want to open a Search All window. From the File menu, choose New..., then Search All. Or 
use the keyboard shortcut CMD-CTRL-F - which puts your cursor in the filed above. Check out the drop-
down menus in this window for various options.

I don’t use Search All much because I find so many results way too cumbersome to cull by 
hand. If you’re interested in knowing more about this feature, however, Dr. J. can help. Click to 
begin download of podcast #41, Search All.

More on Searching
The webpage that has Lighting the Lamp podcasts arranged by topic is a good place to find more on 
searching in Accordance. The link is http://www.accordancebible.com/downloads/Podcasts#topics. Scroll 
down to the topic “How to Search.” 

Copy and Paste

Copy and Paste with the Widget
When you install Accordance, you also install the Accordance widget on 
your dashboard. With the widget, you can look up, copy, and paste any 
Bible verse from any text in your Accordance library to any program you are 
entering text into. Click on the i in the right hand corner of the widget to 
choose the text you want to search, as well as whether you want 
Accordance to insert the verse(s) you search for automatically into the 
uppermost program that is open on your desktop. 
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Paste Greek and Hebrew with the Widget
You can look up Greek and Hebrew passages, and when you copy and paste them from the widget, they 
export in unicode font, which is great except when you use Microsoft Word, which doesn’t play well with 
Hebrew unicode fonts. Export instead into Text Edit, or Pages, or Google Docs. If you must export into 
Word, you will have export using the search window results within Accordance and you will have to be 
sure that “Export all characters with unicode format” is unchecked in Accordance/Preferences/Greek and 
Hebrew.

Copy and Paste Search Results
Pretty much anything that is in Accordance can be copied and pasted out of it. As you copy and paste, 
you will want to be mindful of legal and ethical issues involved in working with copyrighted texts such as 
avoiding plagiarism, which includes using material that is not properly cited, thus leaving your reader with 
the wrong impression about its source. With all of that in mind, here is how to copy and paste.

1. Do a search for the text you want. 

2. Highlight the words or verses you want to copy/paste. If you want everything in the search results 
area, click command + a.

3. Right click (or control + click). Alternatively click the Edit menu. 

4. Choose “Copy” or “Copy As...” and then one of the choices. To set how a “Copy as citation” 
shows up, go to the Accordance menu, then Preferences, then Citation.

Export Greek or Hebrew
You have two choices for exporting original languages from Accordance into other programs (such as a 
word processing program). You may:

1. Export in Unicode Font. Unicode is a good idea if your paper is for someone who does not have 
Accordance fonts. A downside to unicode is that Microsoft Word 2011 does not read Hebrew 
unicode fonts reliably. 

To export in unicode, you need to:

a. Check “Export all characters with unicode format” in Accordance/Preferences/Greek and 
Hebrew, and 

b. Export into another program besides Microsoft Word. Use Google docs, or Pages, or Text 
Edit, Libreoffice or Mellel.

2. You might choose to export original languages in Accordance fonts. The upside here is that you 
will get what you see in the Accordance panes, and the accenting and diacriticals will be well-
positioned without much tweaking. The unicode fonts available when you choose to export 
Accordance data in unicode are sometimes sub-optimal when displaying accents and diacriticals. 

To export in non-unicode Accordance fonts:

a. Make sure “Export all characters with unicode format” in Accordance/Preferences/Greek and 
Hebrew is unchecked, and

b. Make sure than anyone you want to give your work to is able to read it. This probably means 
printing out a hard copy for readers, or saving your work as a .pdf if you need an electronic 
copy.
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Analyze

Add a New Text
To see a text alongside another text, click the “Add Parallel” drop-down button and choose the text you 
want to see. It will open at the same point as the text(s) already open. This is a good way to compare 
translations or to see an original language alongside a translation.

Compare Translations
I prefer to compare translations on my own, just having them in side by side panes, but Accordance will 
also mark up translations for you to highlight their similarities and differences. To compare two 
translations that appear in your workspace, just click in the box beside “Compare.” (See yellow arrow in 
graphic below.) You’ll see something that looks like the illustration below. The red vertical lines indicate a 
word missing in the translation with the line. The strike-throughs indicate words not in the other 
translation. 

Add a New Tool
To see a tool, such as Study Bible notes, open under the text you are reading, click the “Add Parallel” 
drop-down button and select the tool you would like to display. 

Create an Interlinear
An interlinear is a Bible that has lines of one text interspersed with lines of another. So you might read two 
English translations, word for word, stacked on top of each other, or you might build an interlinear with 
Greek and English, or, with a Septuagint text also in the Hebrew Bible, you could build an interlinear with 
Hebrew, then the LXX, then English written line by line. 

1. Create an interlinear in Accordance 10 by clicking the Interlinear box at the right hand end of the 
search area.

 

2. Tweak your interlinear and save your setup by exploring the interlinear menu that appears when 
you click this. For more on this feature, Click this to begin download (m4v) of Dr. J’s Dynamic 
Interlinear podcast (though this is for the v9.5 application).
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Look up a Word in a Lexicon
Triple-Click
When you are reading a Greek text, Instant Details will give you a thumbnail definition of any word you 
hover over. To find the word’s entry in a lexicon, triple-click the word. The lexicon listed first in your library 
will open. 

Tip: To change the order of tools and texts in the library, open the Library Window and drag and drop your 
preferred lexicon to the top of the Greek tools list. 

Search for More than Greek Entries in a Lexicon
Notice that you can search for any word, abbreviation, scripture passage, and other things besides a 
Greek entry in a lexicon. Click on the drop down menu alongside a tool’s name for a list of possible 
search criteria. You can add multiple search criteria by adding extra fields.

Work with Details Graphs and Tables

After any search, click that small graph icon to see details concerning your search results. The 
best quick introduction I’ve found to this feature is Dr. J’s podcast that looks at using the details area 
using just the results of an English word search. The podcast is on Accordance 8, so the interface is 
slightly different in 9.0 and later, but it’s still an informative few minutes. Click to begin download of 
podcast #36 (m4v). 

Display Parallel Texts
Accordance has a number of parallel texts available. By “parallel texts” here, I mean parts of scripture that 
are a lot like other parts of scripture. (I don’t mean Bibles open to the same Bible passage in side-by-side 
panes. For that, see “add a new text.”) 

Let’s say you are reading the parable of the sower in Mark 4. You wonder whether this parable is in any 
other gospels. Place your cursor anywhere in the text and click the Amplify button on the Toolbar and then 
select the Parallels/Synoptic in the menu that drops down. Parallel texts from Mark, Matthew, and Luke 
will open in a new window pane. Click “add text” to add an additional English or Greek text to the one that 
appears. 

Accordance includes various parallel texts. To find out about the parallel text you are reading, from the 
Accordance menu, click About The Text. 

Other Language Tools

Type in Greek
You have two options for typing Greek in Accordance. You may either use the Greek Polytonic keyboard 
that is part of the Mac operating system, or you may type using a U. S. keyboard and Helena font that is 
part of Accordance and is installed in your fonts folder when you install Accordance. 

Unicode Fonts: Readable across Platforms, Browsers & Programs
Greek Polytonic is a unicode font, which means that when you use it in a paper or a discussion forum, 
other people can read it without any special fonts installed. Helena is not unicode, which means that only 
computers with Helena installed will be able to read Greek typed in Helena. If you set up the Greek 
Polytonic keyboard once, you can use it anytime you need to type Greek, whether inside Accordance or 
in other programs.
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To type using Greek Polytonic keyboard:

The Greek Polytonic keyboard is part of your Macintosh 
operating system. To add this keyboard to your options for 
typing, go to the Apple menu, then open System 
Preferences, then Language and Text. Choose Greek 
Polytonic from the list of language options.

Now, you should see a small American flag in the menu 
bar at the top right of your screen. If you click on this, you 
will see the option to choose either the U.S. keyboard, or 
the Greek Polytonic keyboard. When you choose the 
Greek keyboard, your typing will show up in Greek. Use 
the Show Keyboard Viewer menu item to see what letters 
and accents are assigned to which keys.

Next, you need to tell Accordance you are typing Greek 
according to the Greek Polytonic keyboard layout and not 
the Accordance Helena keyboard layout. 

Inside Accordance, go to the Accordance menu, then 
Preferences, then Greek and Hebrew, and make sure 
“Use Greek Polytonic keyboard layout” is checked. 

NOTE: When you are typing inside Accordance, you will 
not need to switch the keyboards manually, that is, by 
using the flag icons in the menu bar. When you are 
searching a Greek text, Accordance will automatically 
type Greek. Setting up the Greek Polytonic keyboard just 
means you won’t have to learn two keyboard layouts (one 
for typing Greek in Accordance and another for typing 
Greek in any other software program). 

To type using Helena (the Accordance font):
The other option for typing in Greek in Accordance is to use the Accordance-specific Helena font. You 
don’t have to do anything special to type in this font. Just make sure that in Accordance Preferences, 
Greek and Hebrew, “Use Greek Polytonic keyboard layout” is unchecked. When you are searching a 
Greek text, the keyboard will automatically convert to Greek. To find the Helena keyboard layout, 
download the Accordance fonts .pdf. The Helena keyboard layout is on p. 6 of that pdf.
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Using the Language Tools on the Resource Palette
These features are all accessible from the Toolbar. 

Hear a Text

To hear a text read aloud, highlight the text you want to hear, then do either of these things:

1. Either right-click (or control + click), and in the context menu that appears, choose 
Look Up, then Speak. 

2. Or click the “speech” button (pictured at left) on the Toolbar (if you have placed it 
there). 

It takes a moment for the speech to start, and it sounds like the voice coming out of a 
weather radio, but still, it’s pretty cool. (Change the voice you hear in Preferences/Speech.)

See Words of a Text Parsed

Accordance will parse every word in a highlighted portion of text. To use this feature, 
highlight the text you want parsed and click the button pictured at the left on the Resource 
Palette. You can change how your results display by clicking command + T inside the 
window that appears.

Diagram a Text

Accordance includes a diagramming module. In the search results area of the 
workspace, highlight the sentence or other portion of text you want to work with and click 
the Toolbar button shown here at the left. A new window opens, with the text color-coded 
by part of speech. 

Tips
• Open Instant Details (Window menu, then Instant Details) to see parsing and other 

information about words in your diagramming pane.

• Press command + T to change the color coding or choose to have the text all in black. 

• Group words together (such as all the words in a prepositional phrase) with the shortcut 
command + G.

• Click and drag the words in the text any way you would like. 

• Hover over the lines and arrows at the left, and a description of what they are used for 
in diagramming will appear at the bottom of the pane.

• Change the font sizes and formatting of words by using the buttons at the top of the 
pane. 

• You may print your work and/or save it as a picture or .pdf. Right-click (or control + 
click) for options. 

• Click the question mark at the bottom of the diagramming window for more information 
on this tool in Accordance help.

More Diagramming Help
Watch Dr. J’s podcast on diagramming. Click to download podcast #32 (m4v).
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Create a Word Chart

You may want to parse and/or define all of the words of a particular text in order to study 
it. Experiment with the Create Word Chart feature of Accordance. Highlight the text you 
want to see in a word chart and, on the Resource Palette, click the button pictured at the 
left here.You can adjust what is displayed in your Word Chart by clicking command + T. 
You can also type in the word chart. Copy or print the Word Chart by using the right-click 
(or control + click) menu.

Create vocabulary lists.
If you are studying a particular book or chapter of the Bible and want to focus your vocabulary study on 
words that appear in that text, here is how.

Find All Words in a Text
1. To find all words in 1 John, type  * <AND> [Range =1Jn] and click Return. You can type this line 

manually into the search box or choose each command from the Search menu of Accordance. 

a. The asterisk (*) is a wild card meaning “any word.” 

b. The <AND> links that wild card to what comes after it.

c. The RANGE command allows you limit your search to a range of verses, chapters or books. 
If you try this search, you’ll notice that your search results window displays the whole text of 1 

John in highlighting. Not that helpful. But click on the details graph icon , and choose 
“Analysis” from the drop down menu. Here you will find all the words in 1 John along with 
their definition and the number of times they appear in the letter. You can ask for the list to be 
displayed in “count down,” which will give you the most commonly used words first and 
continue to those words used only once in the letter. You can change what information is 
displayed in the Analysis window by clicking command + T. 

Find All Words Not in the “Most Used 300” in a Text
By the end of the first semester of Greek, you probably have pretty much memorized all those words that 
occur 50 times or more in the New Testament, so it might be more helpful to create a list of the extra 
words you need to learn for 1 John, rather than all the words in 1 John. 

In order to find all vocabulary in 1 John that is not in the list you already have memorized (those words 
used 50 times or more), you will need to run two searches and relate the results of the first search to the 
second search. This is easier than it sounds.

1. Open a new search text (command + N), make sure you are searching a Greek text (GNT-T) and that 
“All Text” is what you are searching. 

2. Type [COUNT 1-49] and click Return.

a. The COUNT command is a stand-alone command and here says that the way you want to 
limit your search is that you want all words occurring fewer than 50 times. 
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3. At this point, when you open the Details window to Analysis, you will see that you have about 5000 
words. What you want to do now is find those words in 1 John that are also on that list of words 
occurring fewer than 50 times in the NT. So... don’t close or reuse that tab. Just open a new search 
text (command + N). Again, make sure your are searching a Greek text (GNT-T). 

a. From the Search Menu, choose Enter Command... Hits (shortcut is Command + Shift + H). If 
you have more than one search tab open, a question mark will be highlighted beside Hits and 
a dialog box will appear asking which tab you want hits from. Choose the hits from the search 
you just did. In my example, I would choose GNT-T 2.

b. From the Search Menu, choose Enter Command... And (shortcut is Command + Shift + A).

c. From the Search Menu, choose Enter Command... Range (shortcut is Command + Shift + R). 
and type 1Jn in the highlighted area that appears. Click Return to initiate the search.

d. After this search, click the Details graph icon and choose “Analysis.” Now you should see a 
list that looks something like the list below (I’ve truncated the list for this illustration). Notice 
that I’ve asked Accordance to sort results with “Count down” in the left hand corner of the 
Analysis tab. This shows my results (91 words) used most frequently to least frequently in 1 
John. 
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Create vocabulary flashcards.

After you get a list like the one at the left, you can 
create flashcards using Text Edit and either 
Flashcard Exchange or Mental Case. Basically, 
you need to: 

1. Copy and paste your Analysis window results 
into Text Edit.

2. Tidy up your results to that the only commas in 
the document are separating Greek words from 
their definition(s).

3. Save & convert the Text Edit document into  a 
file that Flashcard Exchange or Mental Case can 
read (probably a .csv file).

4. Import the words and definitions into one of the 
flashcard making programs.

After you have done this a couple of times, it’s 
pretty painless. 

Watch a screencast from Accordance’s own Rick 
Bennet on creating flashcards at http://
www.accordancebible.com/Flashcards-And-
Accordance. 

18

http://www.accordancebible.com/Flashcards-And-Accordance
http://www.accordancebible.com/Flashcards-And-Accordance
http://www.accordancebible.com/Flashcards-And-Accordance
http://www.accordancebible.com/Flashcards-And-Accordance
http://www.accordancebible.com/Flashcards-And-Accordance
http://www.accordancebible.com/Flashcards-And-Accordance

